
NetWare 3270 LAN Workstation for Windows Help Index
This index lists all the Help topics available for the NetWare 3270 LAN Workstation for 
Windows software. Topics are listed alphabetically within these categories: new user 
help, keyboard shortcuts, menus, commands, procedures, dialog boxes, windows, and 
communication-link errors.
For information about how to use help, select the Help menu and choose Using Help 
(<Alt-H-U>).
To get NetWare 3270 LAN Workstation for Windows Help, press the <F1> key while you 
are in a NetWare 3270 LAN Workstation for Windows window or after you select a 
command from a NetWare 3270 LAN Workstation for Windows menu.

Note: If you remap the <F1> key in the Unshifted mode while you are in the 
Config Keyboard Map window to <PF1>, then you cannot get help by pressing 
the <F1> key. To restore access to the help, map <Ctrl-F1> to the <Wnd> key. 
You can then get help by pressing the <Ctrl-F1> keys.

To see entries not currently displayed in the Help window, use the scroll bar.

New User Help

What Is NetWare 3270 LAN Workstation for Windows?
Procedures

Keyboard Shortcuts

Keyboard Shortcuts

Program Controls

Menus
Commands
Dialog Boxes
Windows

Communication-Link Errors

Error 590
Error 595



Index of Menus

Active Keyboard Map Window:
File Menu
Shifts Menu

Active Keypad Map Window:
File Menu

Config Keyboard Map Window:
Display Menu
Edit Menu
File Menu
Shifts Menu

Config Keypad Map Window:
Display Menu
Edit Menu
File Menu

Printer Session Window:
File Menu
Config Menu
Utility Menu

Receive Session Window:
Config Menu

Send Session Window:
Config Menu

Session Window:
Config Menu
Edit Menu
File Menu
Transfer Menu
Utilities Menu
Window Menu



Index of Commands

Active Keyboard Map Window:
Alt-Shifted Command
APL Command
Base (Non-APL) Command
Caps Lock Command
Ctrl-Shifted Command
Exit Command
International Command
Num Lock Command
Open Command
Shifted Command
Unshifted Command

Active Keypad Map Window
Exit Command
Open Command

Config Keyboard Map Window:
Alt-Shifted Command
APL Command
APL Code Page Command
Base (Non-APL) Command
Caps Lock Command
Copy Command
Ctrl-Shifted Command
Cut Command
EBCDIC Code Page Command
Exchange Command
Exit Command
Function List Command
International Command
Num Lock Command
Open Command
Paste Command
Save Command
Save As Command
Shifted Command
Undo Command
Unshifted Command

Config Keypad Map Window:



APL Code Page Command
Copy Command
Cut Command
EBCDIC Code Page Command
Exchange Command
Exit Command
Function List Command
Keyboard Command
New Command
Open Command
Paste Command
Save Command
Save As Command
Undo Command

Printer Session Window:
Connection Command
Connection Reminder Command
Dual Case Command
Exit Command
New Session Command
Opcode Check Command
Printer   Setup Command  
Reset Config Command
Save Command
Save As Command
Select Code Page Command

Receive Session Window:
Options Command

Send Session Window
Options Command

Session Window:
Code Page Command
Colors Command
Connection Command
Connection Reminder Command
Copy Command
Exit Command
(Fonts) 24x80 Screen Mode Command
(Fonts) Adjust to Fit Command
(Fonts) Large Screen Mode Command



Function List Command
Keyboard Command (Config Menu)
Keyboard Command (Window Menu)
Keypad Command (Config Menu)
Keypad Command (Window Menu)
New Session Command
Paste Command
Receive Command
Reset Config Command
Save Command
Save As Command
Send Command
Terminal Setup Command



Index of Procedures

Changing Colors Supported by the Hardware Driver
Changing Host-Assigned Colors
Changing Presentation Space Colors to Monochrome
Choosing 3270 Host or Regular PC Colors
Choosing the EBCDIC Code Page
Choosing Form Feeds
Choosing Numeric Lock
Choosing Opcode (Op) Check Returns
Choosing Screen Updating (Refresh)
Configuring the Keyboard
Configuring the Keypad
Copying and Pasting Keyboard/Keypad Keys
Copying and Pasting Presentation Space Data
Copying Code Page and Function List Keys
Copying Dead Keys
Cutting and Pasting Keyboard/Keypad Keys
Exchanging Keyboard/Keypad Keys
Executing 3270 Functions in the Presentation Space
Opening a Keyboard or Keypad File
Opening a Novell-Provided Keyboard File
Opening a Session
Receiving a File from the Host
Resizing Screen Fonts
Saving a File
Sending a File to the Host



Index of Dialog Boxes

3270 Workstation Color Control Dialog Box
APL Code Page Dialog Box
Configuration File Selection Dialog Box
Connection Configuration Dialog Box
Connection Reminder Dialog Box
Define Custom Color Dialog Box
EBCDIC Code Page Dialog Box
(Fonts) 24x80 Screen Mode Dialog Box
(Fonts) Large Screen Mode Dialog Box
Function List Dialog Box
International Keyboard Map Dialog Box
New Keypad Dialog Box
Open File Dialog Box
Printer Setup Dialog Box
Reset Dialog Box
Save As Dialog Box
Select Code Page Dialog Box
Send/Receive Options Dialog Box
Terminal Setup Dialog Box



Index of Windows

Active Keyboard Map Window
Active Keypad Map Window
Config Keyboard Map Window
Config Keypad Map Window
Function List Window
Printer Session Window
Receive Session Window
Send Session Window
Session Window



This index lists topics on which help is available. To get information, choose that topic.



Error 590
If this error occurs, it appears in positions 24 to 30 of the OIA status line. See your IBM 
documentation for descriptions of other error codes.
Indicates that the gateway-to-workstation link is disconnected. See your network 
administrator.



Error 595
If this error occurs, it appears in positions 24 to 30 of the OIA status line. See your IBM 
documentation for descriptions of other error codes.
Indicates that the SAA service you are accessing is disconnected. See your network 
administrator.



What Is NetWare 3270 LAN Workstation for Windows?
NetWare 3270 LAN Workstation for Windows allows you to emulate an IBM 3270 terminal 
while running Microsoft Windows version 3.0a or 3.1. NetWare 3270 LAN Workstation for 
Windows operates in a window. After opening this window, you can log on to an IBM host 
from your workstation as if you were logging on from an IBM 3270 terminal.

When creating sessions, the NetWare 3270 LAN Workstation for Windows software links 
the workstation with a network server running Novell NetWare version 3.11 or above. 
This server runs NetWare for SAA version 1.0 or above, which provides a communication 
link between the workstation and host computer.

For more information, see the NetWare 3270 LAN Workstation for Windows User's Guide. 
The first chapter shows examples of typical network configurations that use the NetWare 
3270 LAN Workstation for Windows software.



File Menu, Active Keyboard Map Window
This menu includes these commands:

Exit Command
International Command
Open Command



Shifts Menu, Active Keyboard Map Window
This menu includes these commands:

Alt-Shifted Command
APL Command
Base (Non-APL) Command
Caps Lock Command
Ctrl-Shifted Command
Num Lock Command
Shifted Command
Unshifted Command



File Menu, Active Keypad Map Window
This menu includes these commands:

Exit Command
Open Command



File Menu, Config Keyboard Map Window
This menu includes these commands:

Exit Command
International Command
Open Command
Save Command
Save As Command



Edit Menu, Config Keyboard Map Window
This menu includes these commands:

Copy Command
Cut Command
Exchange Command
Paste Command
Undo Command



Shifts Menu, Config Keyboard Map Window
This menu includes these commands:

Alt-Shifted Command
APL Command
Base (Non-APL) Command
Caps Lock Command
Ctrl-Shifted Command
Num Lock Command
Shifted Command
Unshifted Command



Display Menu, Config Keyboard Map Window
This menu includes these commands:

APL Code Page Command
EBCDIC Code Page Command
Function List Command



File Menu, Config Keypad Map Window
This menu includes these commands:

Exit Command
New Command
Open Command
Save Command
Save As Command



Edit Menu, Config Keypad Map Window
This menu includes these commands:

Copy Command
Cut Command
Exchange Command
Paste Command
Undo Command



Display Menu, Config Keypad Map Window
This menu includes these commands:

APL Code Page Command
EBCDIC Code Page Command
Function List Command
Keyboard Command



File Menu, Printer Session Window
This menu includes these commands:

Exit Command
New Session Command
Printer Setup Command
Save Command
Save As Command



Config Menu, Printer Session Window
This menu includes these commands:

Connection Command
Dual Case Command
Opcode Check Command
Reset Config Command
Select Code Page Command



Utility Menu, Printer Session Window
This menu includes this command:

Connection Reminder Command



Config Menu, Receive Session Window
This menu includes this command:

Options Command



Config Menu, Send Session Window
This menu includes this command:

Options Command



File Menu, Session Window
This menu includes these commands:

Exit Command
New Session Command
Save Command
Save As Command



Edit Menu, Session Window
This menu includes these commands:

Copy Command
Paste Command



Transfer Menu, Session Window
This menu includes these commands:

Receive Command
Send Command



Config Menu, Session Window
This menu includes these commands:

Code Page Command
Colors Command
Connection Command
(Fonts) 24x80 Screen Mode Command
(Fonts) Adjust to Fit
(Fonts) Large Screen Mode Command
Keyboard Command
Keypad Command
Reset Config Command
Terminal Setup Command



Window Menu, Session Window
This menu includes these commands:

Function List Command
Keyboard Command
Keypad Command



Utilities Menu, Session Window
This menu includes this command:

Connection Reminder Command



Printer Session Window
The Printer Session window displays an emulated IBM 3287 printer panel. To use this 
panel, refer to your IBM 3287 Printer Models 1 and 2 Operator's Guide (IBM part number 
GA27-3150-2). (This window also has menus with command items, but these are not part
of the 3287 panel.) Novell's emulation of the IBM 3287 printer panel is similar to the IBM 
3287, except as follows:

When the On/Off switch is on, you cannot use the Printer Setup and Exit commands 
(File menu) and the Config menu. These menus are in the Printer Session window.

If you are using the Setup or Index switches in the simulated panel, issue a form feed 
by using the Form Feed switch on the simulated panel after you use the switches. Otherwise,
you will be unable to see the effect of using the Setup or Index switch on the printout.

Use the menus in this window to
Open, save, and/or exit sessions (using the File menu) 
Set up printer drivers (using the File menu)
Choose Op Checks, an EBCDIC code page, and the LU3 character case for printing 

(using the Config menu)
Reset unsaved changes to their original values in the current configuration file (using 

the Config menu)



New Session Command
Displays the Configuration File Selection dialog box that allows you to create a new 
configuration file or open an existing one.
Related Topics
Configuration File Selection Dialog Box
Opening a Session



Save Command
Saves changes you made.



Save As Command
Displays the Save As dialog box that allows you to save changes to the file, rename it, 
and save it to a different directory.
Related Topics
Save As Dialog Box
Saving a File



Printer Setup Command
Displays the Printer Setup dialog box that allows you to choose:

The printer to be used for printing
The Print Manager (see your Microsoft Windows documentation for an explanation of 

the Print Manager)
Setup options for the printer (see your printer documentation for an explanation of 

these options or choose the Help button)
You cannot use this command if the On/Off switch in the Printer Session window 
(simulating a 3287 printer panel) is on. For details about the Printer Setup window, see 
your IBM 3287 printer documentation.
Related Topics
Printer Setup Dialog Box



Exit Command
Exits the Printer Session window. You cannot use this command if the On/Off switch in the
Printer Session window (simulating a 3287 printer panel) is on. For details about this 
panel, see your IBM 3287 printer documentation.



Select Code Page Command
For the printer session, displays the Select Code Page dialog box that allows you to 
choose which EBCDIC code page will be used for printing characters.
You cannot use this command if the On/Off switch in the Printer Session window 
(simulating a 3287 printer panel) is on. See your IBM 3287 printer documentation for 
details about this panel.
Related Topics
Select Code Page Dialog Box
Choosing the EBCDIC Code Page



Opcode Check Command
Allows you to notify the host to return an opcode check (Op Check). An Op Check can be 
returned if invalid control characters are detected in the data stream that is sent to the 
printer and reported to the host. If Op Check is off, invalid control characters may cause 
a Program Check (PROG error).
You cannot use this command if the On/Off switch in the Printer Session window 
(simulating a 3287 printer panel) is on. See your IBM 3287 printer documentation for 
details about this panel.



Dual Case Command
For an LU3 printer session, allows you to choose to print characters in uppercase and/or 
lowercase. When this mode is off, the LU3 session characters will print in uppercase. This
command does not affect LU1 session characters, which always print in dual case.
You cannot use this command if the On/Off switch in the Printer Session window 
(simulating a 3287 printer panel) is on. See your IBM 3287 printer documentation for 
details about this panel.



Connection Command
Displays the Connection Configuration dialog box that allows you to choose the server 
name, service name, user ID, and LU category. The LU category specifies the LU group 
from which you want to obtain a session. You can choose one of these LU categories:

Any Choose if the LU group (Public, Pooled, or Dedicated) can be any.
Public Choose for an LU that is neither pooled nor dedicated.
Pooled Choose for a group of LUs that have one or more characteristics in common 

(such as all users in this group will have a Model 2 session with Model 2 displays).
Dedicated Choose for an LU that has a unique configuration (such as a reserved 

address for a specific user).
Related Topic
Connection Configuration Dialog Box



Reset Config Command
Displays the Reset dialog box that allows you to reset all changes you made in the Config
menu of the Printer Session window to their configuration file values, if you have not yet 
saved your changes.
You cannot use this command if the On/Off switch in the Printer Session window 
(simulating a 3287 printer panel) is on. See your IBM 3287 printer documentation for 
details about this panel.
Related Topic
Reset Dialog Box



Connection Reminder Command
Reminds you of the server name, service name, LU name, and SLU ID for the current 
session.



New Command
Displays the New Keypad dialog box that allows you to enter the number of keys for a 
new keypad as rows by columns (rows X columns). When saved, a new file with the .pad 
extension is created. You can define up to 7 keys per row or column. You can configure up
to 49 keys.
Related Topic
New Keypad Dialog Box



Open Command
Displays the Open File dialog box that allows you to open any keyboard or keypad file. 
This file can be used for

Entering data into the Presentation Space (under the Windows menu)
Remapping keys (under the Config menu)

Keyboard files have a .kyb extension; keypad files have a .pad extension. The file you 
open can be a Novell-provided keyboard or keypad file, or a file you created by 
remapping the keyboard or keypad. To create a new file, save your changes and rename 
it.
Related Topics
Open File Dialog Box
Opening a Keyboard or Keypad File



Save Command
Saves changes you made.



Save As Command
Displays the Save As dialog box that allows you to save changes to the keyboard or 
keypad map file, rename it, and save it to a different directory.
Related Topics
Save As Dialog Box
Saving a File



Exit Command
Exits the keyboard or keypad window, allowing you to save changes.



Cut Command
Places the selected keyboard or keypad key into the buffer. Some keys cannot be cut. 
This command is chosen from the keyboard or keypad Edit menu.
Related Topic
Cutting and Pasting Keyboard/Keypad Keys



Copy Command
Copies a selected key from the

Keyboard to the keyboard buffer
Keypad to the keypad buffer

Some keys cannot be copied. This command is chosen from the keyboard or keypad Edit 
menu.
EBCDIC code page, APL code page, or function list keys may be copied to the keyboard 
by selecting the code page or function list key and dragging it onto the keyboard. The 
Copy command does not work for copying code page or function list keys.
Related Topics
Copying and Pasting Keyboard/Keypad Keys
Copying Code Page and Function List Keys



Exchange Command
Exchanges the selected keyboard key with the key in the keyboard buffer. Also 
exchanges the selected keypad key with the key in the keypad buffer.
Some keys cannot be exchanged. This command is chosen from the keyboard or keypad 
Edit menu.
Related Topic
Exchanging Keyboard/Keypad Keys



Paste Command
Places the key from the keyboard buffer on a selected keyboard or keypad key. You can 
choose this command from the Edit menu of the keyboard or keypad (Config Keyboard 
Map or Config Keypad Map) opened from the Config menu. You cannot paste keys to the 
keyboard or keypad (Active Keyboard Map or Active Keypad Map) opened from the 
Window menu.
Related Topics
Cutting and Pasting Keyboard/Keypad Keys
Copying and Pasting Keyboard/Keypad Keys



Undo Command
Cancels the last edit change you made to the keyboard or keypad. It does not work if you
have already saved the change. To undo edit changes, choose Undo from the Edit menu 
(<Alt-E-U>).



Base (Non-APL) Command
Changes the keyboard mapping to the standard keyboard layout. In this keyboard 
mapping, the Shifted, Unshifted, Alt-Shifted or Control-Shifted modes can be displayed. 
Either the CapsLock or Num Lock mode can be on, both modes can be on, or both modes
can be off.



APL Command
Changes the keyboard mapping to the APL symbol set. To support the APL symbol set, 
the workstation must have a color monitor, and the display adapter must be an EGA 
(with at least 128 KB of memory), VGA, or built-in adapter of any PS/2 model.
In this key mapping, the Shifted, Unshifted, Alt-Shifted or Control-Shifted modes can be 
on or off. Either the CapsLock or Num Lock mode can be on, both modes can be on, or 
both modes can be off.



Unshifted Command
Changes the keyboard mapping to display the characters produced in the Unshifted 
state.



Shifted Command
Changes the keyboard mapping to display the characters produced in the Shifted state. If
you choose the Shift Lock option box while Caps Lock is on, all keys are locked in the 
Shifted mode. The Shift Lock option box is located in the Keyboard Map window below 
the File menu.



Alt-Shifted Command
Displays the keyboard layout in the Alt-Shifted state.



Ctrl-Shifted Command
Displays the keyboard layout in the Control-Shifted state.



Caps Lock Command
Changes the lowercase letters on the keyboard to uppercase. This function works in Base
or APL mode, and can be used in Shifted, Unshifted, Control-Shifted, or Alt-Shifted mode. 
Choose this command with the Num Lock command, or by itself.



Num Lock Command
Changes the mapping of the numeric keypad from function keys to numbers. This 
function works in Base or APL mode and can be used in Shifted, Unshifted, Control-
Shifted, or Alt-Shifted mode. Choose this command with the CapsLock command, or by 
itself.



Function List Command
Under the keyboard or keypad Display menu, this command displays the Function List 
dialog box that consists of 3270 functions. You can copy functions from the Function List 
to the keyboard or keypad, but you cannot remap them.
Related Topics
Function List Window
Copying Code Page and Function List Keys



EBCDIC Code Page Command
Under the keyboard or keypad Display menu, this command displays the EBCDIC Code 
Page dialog box that consists of the characters and symbols of the current code page. 
You can copy these characters or symbols to the keyboard or keypad, but you cannot 
remap them.
When you choose the code page's Dead Key command, the code page dead keys are 
highlighted. You can use a dead key to create a combination of a character and symbol. 
(For example, you may want to copy an accent from the code page onto a keyboard 
letter to create an accented letter that is used in your country.)
Related Topics
EBCDIC Code Page Dialog Box
Copying Dead Keys
Copying Code Page and Function List Keys



APL Code Page Command
Under the keyboard or keypad Display menu, this command displays the APL code page 
that consists of APL characters and symbols. You can copy these characters or symbols 
from the code page to the keyboard or keypad, but you cannot remap them.
Related Topics
APL Code Page Dialog Box
Copying Code Page and Function List Keys



International Command
Displays the International Keyboard Map dialog box that allows you to choose a Novell-
provided keyboard file (which has a .kyb extension) by its directory path, keyboard size, 
and language mapping.
After you open this file, you can select keys with the mouse to enter data into the 
Presentation Space of the Session window or remap the online keyboard.
If you remap the keyboard, you can save your changes, rename the file, and relocate it 
into a different directory. The next time you need this keyboard map, use the Open 
command to open this new file.
Related Topics
International Keyboard Map Dialog Box
Opening a Novell-Provided Keyboard File



Active Keyboard Map Window/Config Keyboard Map 
Window

The Active Keyboard Map window displays the keyboard that you can use to enter data 
into the Presentation Space. To enter data, choose the required characters using the left 
mouse button or use the physical keyboard.
The Config Keyboard Map window displays the keyboard that you can remap using the 
Cut, Copy, Paste, and Exchange commands in the Edit menu. Keys may be copied from 
the keyboard to the keypad.
Related Topic
Configuring the Keyboard



Active Keypad Map Window/Config Keypad Map Window
The Active Keypad Map window displays the keypad that you can use to enter data into 
the Presentation Space. To enter data, choose the required characters using the left 
mouse button or use the physical keyboard.
The Config Keypad Map window displays the keypad that you can remap using the Cut, 
Copy, Paste, and Exchange commands in the Edit menu. Keys may not be mapped out of 
the keypad.
Related Topic
Configuring the Keypad



Session Window
Displays the 3270 host session. This session includes Presentation Space data and OIA 
symbols. Use the menus in this window to

Open or save session configuration files
Exit an open session
Edit the Presentation Space (copy and paste only)
Change screen fonts, colors, the EBCDIC code page, keyboard mapping, and keypad 

mapping
Choose numeric lock, Op Checks, form feeds, and screen updating (refresh)
Reset the values of the configuration file you opened 
Transfer files between the host and workstation
Use the mouse instead of a keyboard to enter data into the Presentation Space



New Session Command
Displays the Configuration File Selection dialog box that allows you to create a new 
configuration file or open an existing one.
Related Topics
Configuration File Selection Dialog Box
Opening a Session



Save Command
Saves changes you made.



Save As Command
Displays the Save As dialog box that allows you to save changes to the file, rename it, 
and save it to a different directory.
Related Topics
Save As Dialog Box
Saving a File



Exit Command
Exits the Session window, allowing you to save changes.



Copy Command
Copies data selected from the Presentation Space of a Session window to the Windows 
clipboard.
Related Topic
Copying and Pasting Presentation Space Data



Paste Command
Places data selected from the Windows clipboard into any window.
Related Topic
Copying and Pasting Presentation Space Data



Send Command
Displays the Send Session window that allows you to choose a file to transfer from the 
workstation to the host. You can send multiple files simultaneously, one from each 
session. File transfer can run in the background, allowing you to continue working in 
other windows while the transfer is being executed.
Related Topics
Send Session Window
Sending a File to the Host



Receive Command
Displays the Receive Session window that allows you to choose a file to transfer from the
host to the workstation. You can receive multiple files simultaneously, one from each 
host session. File transfer can run in the background, freeing you to do other Windows 
work.
Related Topics
Receive Session Window
Receiving a File from the Host



Transfer Command
**************
Not being implemented for this release. Designed to work with CICS. Command will 
display under Transfer menu of Session window. Context number is 540.
***************
Related Topics



(Fonts) 24x80 Screen Mode Command
Displays the 24x80 Screen Mode dialog box that allows you to resize screen fonts for the 
24x80 mode. This mode is assigned in the host Bind command. The screen size is 
defined as the number of lines (rows) by the number of characters (columns) per line. If 
you are not sure if this mode is active, ask your IBM systems programmer.
Before resizing screen fonts, read the Setting Up the Session Viewing Area section in 
Chapter 5 of the NetWare 3270 LAN Workstation for Windows User's Guide for additional 
information.
Related Topics
(Fonts) 24x80 Screen Mode Dialog Box
Resizing Screen Fonts



(Fonts) Adjust to Fit Command
Enables or disables automatic font resizing. If a check appears to the left of the Adjust to 
Fit command, automatic font resizing is enabled; if the check is cleared, automatic font 
resizing is disabled.
Automatic font resizing chooses a font size from the font sizes installed in your copy of 
Microsoft Windows. The chosen font size is determined by the size and shape of the 
window.
If the shape of the window is close to being proportional to the session display area, the 
program will choose the largest font size that allows all session characters to appear in 
the window. The program may also adjust the size of the window to be exactly 
proportional. If the window is too small to display all the session characters at the 
smallest font size, scroll bars appear. You can use the scroll bars to view other parts of 
the window.
If the shape of the window is tall and narrow or short and wide, the program selects the 
largest font size that fits the longest dimension. For example, when the window is tall 
and narrow, the program selects the largest font size that allows all rows in the session 
window to appear. Scroll bars appear at the bottom of the window so that you can scroll 
to display hidden character columns.
Related Topic
Resizing Screen Fonts



(Fonts) Large Screen Mode Command
Displays the Large Screen Mode dialog box that allows you to resize screen fonts for the 
large screen mode. This mode is assigned in the host Bind command. The screen size is 
defined as the number of lines (rows) by the number of characters (columns) per line. If 
you are not sure if this mode is active, ask your IBM systems programmer.
Before resizing screen fonts, read the Setting Up the Session Viewing Area section in 
Chapter 5 of the NetWare 3270 LAN Workstation for Windows User's Guide for additional 
information.
Related Topics
(Fonts) Large Screen Mode Dialog Box
Resizing Screen Fonts



Colors Command
For the workstation's color monitor, this command displays the 3270 Workstation Color 
Control dialog box that allows you to

Change host-assigned base, default extended, extended, background/blinking, and 
OIA colors

Change your Presentation Space colors to monochrome
Choose 3270-type colors or regular PC colors
Redefine a color square in the dialog box to any of 256 colors (if you have a hardware

driver that supports 256 colors)
Redefine any Session window color based on the color squares
Reset colors to adapter default colors

Related Topics
3270 Workstation Color Control Dialog Box
Changing Colors Supported by the Hardware Driver
Changing Host-Assigned Colors
Changing Presentation Space Colors to Monochrome
Choosing 3270 Host or Regular PC Colors



Code Page Command
Displays the Select Code Page dialog box that allows you to choose the EBCDIC code 
page that will be used during the session.
Related Topics
Select Code Page Dialog Box
Choosing the EBCDIC Code Page



Keyboard Command (Config Menu)
Displays the Config Keyboard Map window that consists of the keyboard map. You can 
remap the keyboard using the Edit menu or your mouse.
Related Topics
Config Keyboard Map Window
Configuring the Keyboard



Keypad Command (Config Menu)
Displays the Config Keypad Map window that consists of the keypad map. You can remap 
the keypad using the Edit menu or your mouse.
Related Topics
Config Keypad Map Window
Configuring the Keypad



Connection Command
Displays the Connection Configuration dialog box that allows you to choose the server 
name, service name, user ID, and LU category. The LU category specifies the LU group 
from which you want to obtain a session. You can choose one of these LU categories:

Any Choose if the LU group (Public, Pooled, or Dedicated) can be any.
Public Choose for an LU that is neither pooled nor dedicated.
Pooled Choose for a group of LUs that have one or more characteristics in common 

(such as all users in this group will have a Model 2 session with Model 2 displays).
Dedicated Choose for an LU that has a unique configuration (such as a reserved 

address for a specific user).
Related Topic
Connection Configuration Dialog Box



Terminal Setup Command
Displays the Terminal Setup dialog box that allows you to choose numeric lock, opcode 
checks, form feeds, and/or screen updating (refresh) as follows:

Numeric lock locks the keyboard when an attempt to enter non-numeric data into a 
numeric field is made.

Opcode checks (Op Checks) can be returned by the host if invalid control characters 
are detected in the data stream and are reported to the host, or a Query Retry State error is 
reported to the host. If checking is off, invalid control characters may display as hyphens.

Form feeds determine blank page ejection during printing of screens.
Screen updating (refresh) determines how the screen is painted with host data.

Related Topics
Terminal Setup Dialog Box
Choosing Numeric Lock
Choosing Opcode (Op) Check Returns
Choosing Form Feeds
Choosing Screen Updating (Refresh)



Reset Config Command
Displays the Reset dialog box that allows you to reset all changes you made using the 
Config menu of Session window to their configuration file values, if you have not yet 
saved your changes.
Changes you made to the keyboard are reset only if the Config Keyboard Map window is 
open at the time you choose the Reset Config command.
Related Topic
Reset Dialog Box



Function List Command
Displays the Function List window that consists of the 3270 functions. You can execute 
these functions in the Presentation Space using the left mouse button.
Related Topics
Function List Window
Executing 3270 Functions in the Presentation Space



Function List Window
Displays the 3270 functions you can execute in the Presentation Space using the left 
mouse button.



Keyboard Command (Window Menu)
Displays the Active Keyboard Map window that you can use to enter data into the 
Presentation Space. To enter data, choose the required characters using the left mouse 
button.
Related Topic
Active Keyboard Map Window



Keypad Command (Window Menu)
Displays the Active Keypad Map window that you can use to enter data into the 
Presentation Space. To enter data, choose the required characters using the left mouse 
button.
Related Topic
Active Keypad Map Window



Connection Reminder Command
Reminds you of the server name, service name, LU name, and SLU ID for the current 
session.



Send Session Window/Receive Session Window
These windows allow you to transfer files between your workstation and the host. Use 
the Send Session window to send a file to the host; use the Receive Session window to 
receive a file from the host.
The Send Session window allows you to choose the host filename, which file will be sent, 
and where the file is located. After you send the file, status information displays to 
indicate when file transfer is complete, the number of files sent, and the total number of 
bytes sent.
The Receive Session window allows you to choose where the file received from the host 
will be placed, and the host filename. After the file is received, status information 
displays to indicate the total number of bytes received.
Before you choose the Send or Receive button, you may want to choose options for the 
file you are transferring. See the Options command, the Sending a File to the Host 
procedure, or the Receiving a File from the Host procedure for more information about 
options.
Related Topics
Send Command
Options Command (Send)
Sending a File to the Host
Receive Command
Options Command (Receive)
Receiving a File from the Host



Options Command
For the transfer (send) function, displays the Send/Receive Options dialog box that allows
you to choose CMS, TSO, or CICS options for the file to be sent to the host. See your 
CMS , TSO, or CICS documentation for an explanation of these options.
These options include file append, ASCII or binary file format, Carriage Return Line Feed 
(CRLF) recognition as record separators, record length, block size, packet size, timeout, 
and record format.
Timeout is the maximum amount of time, in seconds, that the file transfer program waits
for a response from the host before an error message appears and transfer terminates.
Timeout Retries indicates file transfer delay by displaying the number of times the host 
response time was greater than 30 seconds.

Note: A timeout value of 150 seconds is recommended for large packets, large 
blocks, or slow communication lines.

For TSO, you can also enter the amount of space to be allocated for the file and how this 
space is to be allocated.
For CICS, you can enter the CICS Options/Comments. These are special CICS options, 
enclosed in parentheses and followed by comments (if there are any). If no special 
options are needed, but comments need to be sent, enter empty parentheses without 
anything inside of them, and then enter the comments.
Related Topics
Send/Receive Options Dialog Box
Sending a File to the Host



Options Command
For the transfer (receive) function, displays the Send/Receive Options dialog box that 
allows you to choose CMS, TSO, or CICS options for the file to be received from the host. 
See your CMS, TSO, or CICS documentation for an explanation of these options.
These options include file append, ASCII or binary file format, Carriage Return Line Feed 
(CRLF) recognition as record separators, block size, packet size, and timeout.
Timeout is the time lapsed after the host has not responded, and before an error 
message appears and file transfer terminates. It is the maximum amount of time you 
want to wait before the transfer terminates.

Note: A timeout value of 150 seconds is recommended for large packets, large 
blocks, or slow communication lines.

Related Topics
Send/Receive Options Dialog Box
Receiving a File from the Host



Keyboard Shortcuts

Use the following keyboard shortcuts, listed alphabetically by command name, in NetWare 
3270 LAN Workstation for Windows:

Command Keyboard Shortcut

Alt-Shifted (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<T>

Alt-Shifted (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <T>

APL (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<A>

APL (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <A>

APL Code Page (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <D> 
<A>

APL Code Page (Config Keypad Map Window) <Alt> <C> <P> <Alt> <D> 
<A>

Base (Non-APL) (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<B>

Base (Non-APL) (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <B>

Caps Lock (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<C>

Caps Lock (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <C>

Code Page <Alt> <C> <G>

Colors <Alt> <C> <C>

Connection (Printer Session Window) <Alt> <C> <C>

Connection (Session Window) <Alt> <C> <N>

Connection Reminder <Alt> <U> <C>

Copy <Alt> <E> <O>

Copy (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <O>

Copy (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <O>

Ctrl-Shifted (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<R>

Ctrl-Shifted (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <R>



Cut (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <C>

Cut (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <C>

Dual Case <Alt> <C> <D>

EBCDIC Code Page (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <D> <E>

EBCDIC Code Page (Config Keypad Map Window) <Alt> <C> <P> <Alt> <D> <E>

Exchange (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <X>

Exchange (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <X>

Exit <Alt> <F> <X>

(Fonts) 24x80 Screen Mode <Alt> <C> <F> <D>

(Fonts) Adjust to Fit <Alt> <C> <F> <A>

(Fonts) Large Screen Mode <Alt> <C> <F> <A>

Function List (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <D> <L>

Function List (Config Keypad Map Window) <Alt> <C> <P> <Alt> <D> <L>

Function List (Session Window) <Alt> <W> <L>

International (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <F> <I>

International (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <F> <I>

Keyboard (Active Keyboard Map Window) <Alt> <W> <K>

Keyboard (Config Keyboard Map Window) <Alt> <C> <K>

Keypad (Active Keypad Map Window) <Alt> <W> <P>

Keypad (Config Keypad Map Window) <Alt> <C> <P>

New <Alt> <C> <P> <Alt> <F> <N>

New Session <Alt> <F> <N>

Num Lock (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<M>

Num Lock (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> 
<M>

Opcode Check <Alt> <C> <O>

Open (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <F> 
<O>



Open (Active Keypad Map Window) <Alt> <W> <P> <Alt> <F> 
<O>

Open (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <F> <O>

Open (Config Keypad Map Window) <Alt> <C> <P> <Alt> <F> <O>

Options (Receive Session Window) <Alt> <T> <R> <Alt> <N> 
<O>

Options (Send Session Window) <Alt> <T> <S> <Alt> <N> 
<O>

Paste <Alt> <E> <P>

Paste (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <P>

Paste (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <P>

Printer Setup <Alt> <F> <P>

Receive <Alt> <T> <R>

Reset Configuration <Alt> <C> <R>

Save <Alt> <F> <S>

Save As <Alt> <F> <A>

Select Code Page <Alt> <C> <S>

Send <Alt> <T> <S>

Shifted (Active Keyboard Map Window) <Alt> <W> <K > <Alt> <S>
<I>

Shifted (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <I>

Terminal Setup <Alt> <C> <T>

Undo (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <U>

Undo (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <U>

Unshifted (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<N>

Unshifted (Config Keyboard Map Window) <Alt> <C> <K>  <Alt> <S> 
<N>



Commands

Use the following commands in NetWare 3270 LAN Workstation for Windows:

Command Keyboard Shortcut
and Function

Alt-Shifted (Active Keyboard Map Window) <Alt> <A> <K> <Alt> <F> <I>
Changes the keyboard to the 
characters you use with the <Alt> 
<Shift> keys.

Alt-Shifted (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <F> <I>
Changes the keyboard to the 
characters you use with the <Alt> 
<Shift> keys.

APL (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<A>

In APL mode, remaps the keyboard 
to APL characters and symbols.

APL (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <A>

In APL mode, allows you to remap 
APL characters and symbols on the 
keyboard.

APL Code Page (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <D> 
<A>

Displays the APL Code Page so that
APL characters can be copied to 
the keyboard.

APL Code Page (Config Keypad Map Window) <Alt> <C> <P> <Alt> <D> 
<A>

Displays the APL Code Page so that
APL characters can be copied to 
the keypad.

Base (Non-APL) (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<B>

Displays a keyboard with the 
national keyboard characters and 
symbols that you can activate with 
a mouse.

Base (Non-APL) (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <B>
Displays a keyboard with the 



national keyboard layout that you 
can remap.

Caps Lock (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<C>

Displays the keyboard alphabet in 
uppercase.

Caps Lock (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <C>
Displays the keyboard alphabet for 
remapping in uppercase.

Code Page <Alt> <C> <G>
Displays the EBCDIC Code Page 
settings used during the session.

Colors <Alt> <C> <C>
Changes and/or redefines custom 
colors in the session.

Connection (Printer Session Window) <Alt> <O> <C>
Specifies the server name, service 
name, user ID, and LU category.

Connection (Session Window) <Alt> <C> <N>
Specifies the server name, service 
name, user ID, and LU category.

Connection Reminder <Alt> <U> <C>
Reminds you what the server 
name, service name, user ID, and 
LU category are.

Copy <Alt> <E> <O>
Copies session data to the Windows
Clipboard.

Copy (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <O>

Copies keyboard keys to the 
keyboard buffer.

Copy (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <O>

Copies keypad keys to the keypad 
buffer.

Ctrl-Shifted (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <C> 
<K>

Displays the keyboard characters 
produced in the Control-Shifted 



state.

Ctrl-Shifted (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <R>

Allows you to remap the keyboard 
characters defined in the Control-
Shifted state.

Cut (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <C>
Places the selected keyboard key 
into the keyboard buffer.

Cut (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <C>
Places the selected keypad key into
the keypad buffer.

Dual Case <Alt> <O> <D>
Sets the printer to print uppercase 
and lowercase letters.

EBCDIC Code Page (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <D> <E>
Displays the EBCDIC Code Page.

EBCDIC Code Page (Config Keypad Map Window) <Alt> <C> <P> <Alt> <D> <E>

Displays the EBCDIC Code Page.

Exchange (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <X>

Exchanges a keyboard key with the
key in the keyboard buffer.

Exchange (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <X>
Exchanges a keypad key with the 
key in the keypad buffer.

Exit (Printer Session Window) <Alt> <I> <X>
Exits the printer session.

Exit (Session Window) <Alt> <F> <X>
Exits the session, keyboard, or 
keypad.

(Fonts) 24x80 Screen Mode <Alt> <C> <F> <2>
Resizes screen fonts for the 24x80 
Screen mode.

(Fonts) Adjust to Fit <Alt> <C> <F> <A>
Selects Adjust to Fit font resizing.



(Fonts) Large Screen Mode <Alt> <C> <F> <L>
Resizes screen fonts for Large 
Screen mode.

Function List (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <D> <L>
Displays the 3270 functions you 
can copy to the keyboard.

Function List (Config Keypad Map Window) <Alt> <C> <P> <Alt> <D> <L>
Displays the 3270 functions you 
can copy to the keypad.

Function List (Session Window) <Alt> <W> <L>
Displays the 3270 functions you 
can activate with your mouse.

International (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <F> <I>

Opens a Novell-provided file that 
changes the keyboard map to the 
layout of another country.

International (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <F> <I>
Opens a Novell-provided file that 
changes the keyboard map to the 
layout of another country. You can 
then remap this layout.

Keyboard (Active Keyboard Map Window) <Alt> <W> <K>
Displays the keyboard you can use 
to enter data into the session using
a mouse.

Keyboard (Config Keyboard Map Window) <Alt> <C> <K>
Displays the keyboard you can 
remap.

Keypad (Active Keypad Map Window) <Alt> <W> <P>
Displays the keypad you can use to
type data into the session, or 
execute 3270 functions.

Keypad (Config Keypad Map Window) <Alt> <C> <P>
Displays the keypad you can 
remap.

New <Alt> <C> <P> <Alt> <F> <N>
Opens a new keypad, after you 
select its size.

New Session (Printer Session Window) <Alt> <I> <N>



Opens a new printer session.

New Session (Session Window) <Alt> <F> <N>
Opens a new display session.

Num Lock (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<M>

Changes the keyboard's numeric 
keypad to allow numbers to be 
entered.

Num Lock (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> 
<M>

Changes the keyboard's numeric 
keypad to numbers you can remap.

Opcode Check <Alt> <O> <O>
Specifies if the host will return 
opcode checks.

Open (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <F> 
<O>

Displays the keyboard map of any 
keyboard file you open. You can 
then select the keys with your 
mouse to type data into the 
session.

Open (Active Keypad Map Window) <Alt> <W> <P> <Alt> <F> 
<O>

Displays the keypad map of any 
keypad file you open. You can then 
type data into the session or 
execute 3270 functions.

Open (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <F> <O>
Displays the keyboard map of any 
keyboard file you open. You can 
then remap this keyboard.

Open (Config Keypad Map Window) <Alt> <C> <P> <Alt> <F> <O>
Displays the keypad map of any 
keypad file you open. You can then 
remap this keypad.

Options (Receive Session Window) <Alt> <T> <R> <Alt> <N> 
<O>

Sets CMS, TSO, or CICS options for 
the file to be received at the 
workstation from the host.



Options (Send Session Window) <Alt> <T> <S> <Alt> <N> 
<O>

Sets CMS, TSO, or CICS options for 
the file to be sent from the 
workstation to the host.

Paste <Alt> <E> <P>
Places data from the Windows 
clipboard to any open session.

Paste (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <P>
Places the key in the keyboard 
buffer to a keyboard or keypad key.

Paste (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <P>
Places the key in the keypad buffer 
to a keypad key.

Receive <Alt> <T> <R>
Receives a file from the host.

Reset Configuration (Printer Session Window) <Alt> <O> <R>
In the printer session, cancels 
changes you made and restores 
default settings.

Reset Configuration (Session Window) <Alt> <C> <R>
In the display session, cancels 
changes you made and restores 
default settings.

Save (Printer Session Window) <Alt> <I> <A>
Saves changes you made to the 
printer session.

Save (Session Window) <Alt> <F> <A>
Saves changes you made to the 
session, keyboard, or keypad.

Save As (Printer Session Window) <Alt> <I> <A>
Saves changes you made to the 
printer session, renames the file, 
and/or saves it to a different 
directory.

Save As (Session Window) <Alt> <F> <A>
Exits the session, keyboard, or 
keypad. Also renames the file, 
and/or saves it to a different 
directory.



Select Code Page <Alt> <O> <S>
Displays the EBCDIC Code Page 
settings for printing so that you can
change them.

Send <Alt> <T> <S>
Sends a file from the workstation to
the host.

Setup <Alt> <I> <P>
Sets printer options.

Shifted (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> <I>
Displays the keyboard layout in the
Shifted state.

Shifted (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <S> <I>
Displays the keyboard layout in the
Shifted state.

Terminal Setup <Alt> <C> <T>
Displays numeric lock, opcode 
check, form feed, and screen 
update settings you can change.

Undo (Config Keyboard Map Window) <Alt> <C> <K> <Alt> <E> <U>

Cancels the last change you made 
to the keyboard.

Undo (Config Keypad Map Window) <Alt> <C> <P> <Alt> <E> <U>
Cancels the last change you made 
to the keypad.

Unshifted (Active Keyboard Map Window) <Alt> <W> <K> <Alt> <S> 
<N>

Displays the keyboard layout in the
Unshifted state.

Unshifted (Config Keyboard Map Window) <Alt> <C> <K>  <Alt> <S> 
<N>

Displays the keyboard layout in the
Unshifted state.





Changing Colors Supported by the Hardware Driver
This procedure redefines any of the 16 color squares in the color palette (in the 3270 
Workstation Color Control dialog box) to any of the 256 colors supported by the hardware
driver. You can only redefine a color square if you have a hardware driver that supports 
256 colors.

1. Choose the Colors command from the Config menu in the Session window (<Alt> 
<C> <C>). The 3270 Workstation Color Control dialog box appears and the Define
button is enabled.

2. Choose the Pallete mode as instructed in the Choosing 3270 Host or Regular PC 
Colors procedure.

3. Select the color square in which you want to redefine a color.
4. Choose the Define button. The Define Custom Color dialog box displays.
5. Scroll the Red, Green, and Blue boxes until the color you want displays in the color 

rectangle. The value of the Red, Green, or Blue box displays next to the rectangle. 
(To obtain a "pure" red, green, or blue, set its value to 255 and the other two 
colors to 0.)

6. Choose OK. The Define Custom Color dialog box disappears and the color square 
changes to match the color you set in the Define Custom Color dialog box.

Note: To cancel your changes, choose Cancel. The dialog box disappears. To reset
the current colors to the default colors of the workstation adapter, choose 
Optimize and then choose OK. The colors change to the adapter's default colors.

7. Choose OK. The 3270 Workstation Color Control dialog box disappears and your 
changes become effective in the Session window.

Related Topics
Colors Command
3270 Workstation Color Control Dialog Box
Define Custom Color Dialog Box
Choosing 3270 Host or Regular PC Colors
Changing Host-Assigned Colors



Changing Host-Assigned Colors
This procedure changes any host-assigned color in the Presentation Space of the Session 
window so that it matches any of the 16 color squares in the color palette of the 3270 
Workstation Color Control dialog box.

1. Choose the Colors command from the Config menu in the Session window (<Alt> 
<C> <C>). The 3270 Workstation Color Control dialog box appears.

2. Select an option in the base, default extended, extended, background/blinking, or 
OIA color category.

3. Select the needed color from the color palette (one of the 16 color squares on the 
dialog box). The selected option changes to match the color of the selected palette
square.

4. Repeat Steps 2 and 3 until you complete all needed color changes.
Note: To cancel your changes, choose Cancel. The dialog box disappears.

5. Choose OK. The dialog box disappears and your changes become effective in the 
Session window.

Related Topics
Colors Command
3270 Workstation Color Control Dialog Box



Changing Presentation Space Colors to Monochrome
For color monitors, this procedure changes the Presentation Space colors to black and 
white.

1. Choose the Colors command from the Config menu in the Session window (<Alt> 
<C> <C>). The 3270 Workstation Color Control dialog box appears.

2. Select the Monochrome button in the Terminal Mode box. A black dot fills this 
button, and the dialog box changes to display only the monochrome, 
background/blinking, and OIA color categories. The monochrome category displays
the Normal option in gray and the Intensified option in white.

Note: To cancel your changes, choose Cancel. The dialog box disappears.
3. Choose OK. The dialog box disappears and your changes become effective in the 

Presentation Space of the Session window.
Related Topics
Colors Command
3270 Workstation Color Control Dialog Box



Choosing 3270 Host or Regular PC Colors
This procedure allows you to choose either 3270 host colors or regular PC colors for the 
16 squares of the color palette in the 3270 Workstation Color Control dialog box. The 
host colors are brighter than the PC colors.

1. Choose the Colors command from the Config menu in the Session window (<Alt> 
<C> <C>). The 3270 Workstation Color Control dialog box appears.

2. Choose one of these buttons from the Palette Mode box:
To specify 3270 colors, select Host.
To specify the regular PC colors, select PC.

A black dot fills this button.
Note: To cancel your changes, choose Cancel. The dialog box disappears.

3. Choose OK. Your changes become effective in the palette and the dialog box 
disappears.

Related Topics
Colors Command
3270 Workstation Color Control Dialog Box



Choosing the EBCDIC Code Page
This procedure allows you to choose the EBCDIC code page you need for your current 
session. The code page settings for the Printer Session window and the Session window 
must match.

1. To display the Select Code Page dialog box, choose one of these commands:
Select Code Page command from the Config menu in the Printer Session window 

(<Alt> <C> <S>).
Code Page command from the Config menu in the Session window (<Alt> <C> 

<G>).
2. Click the code number box arrow to display the choices.
3. Click the scroll bar arrows to scroll the full list.
4. Choose a code page. Your choice displays in the code number box.
5. Choose OK. After the dialog box disappears, save your changes.
6. If you chose the Select Code Page command in Step 1, now choose the Code Page 

command from the Session window and match code page settings by repeating 
Steps 2 to 5. If you chose the Code Page command in Step 1, now choose the 
Select Code Page command from the Printer Session window and match code page
settings by repeating Steps 2 to 5.

Note: To cancel your choice, choose Cancel. The dialog box disappears.

Related Topics
Select Code Page Command
Code Page Command
Select Code Page Dialog Box



Choosing Form Feeds
This procedure allows you to specify    if a blank page will be ejected before or after 
printing screens.

1. Choose the Terminal Setup command from the Config menu in the Session window 
(<Alt> <C> <T>). The Terminal Setup dialog box appears.

2. Select one of these buttons:
No Form Feed Sets no blank pages to eject before or after printing.
Before Screen Print Sets a blank page to eject before printing.
After Screen Print Sets a blank page to eject after printing.
Both Before and After Screen Print Sets a blank page to eject before and after 

printing.
A black dot fills this button.

3. Select other dialog box options if needed.
4. Choose OK. The dialog box disappears.
Note: To cancel your choice, choose Cancel. The dialog box disappears.

Related Topics
Terminal Setup Command
Terminal Setup Dialog Box



Choosing Numeric Lock
This procedure sets the numeric keypad in Numeric Lock mode, so that the numeric 
keypad displays numbers instead of PF keys.

1. Choose the Terminal Setup command from the Config menu in the Session window 
(<Alt> <C> <T>). The Terminal Setup dialog box appears.

2. Select the On or Off option button. A black dot fills this button.
3. Select other dialog box options if needed.
4. Choose OK. The dialog box disappears.
Note: To cancel your choice, choose Cancel. The dialog box disappears.

Related Topics
Terminal Setup Command
Terminal Setup Dialog Box



Choosing Opcode (Op) Check Returns
This procedure allows you to specify if the host is to return opcode checks for invalid 
code or Query in Retry State error conditions.

1. Choose the Terminal Setup command from the Config menu in the Session window 
(<Alt> <C> <T>). The Terminal Setup dialog box appears.

2. Select one of these buttons:
No Op Check Notifies the host not to return an opcode check if invalid control 

characters are detected in the data stream.
Invalid Codes Notifies the host to return an opcode check if invalid control characters

are detected in the data stream.
Query Retry State Notifies the host to return an opcode check if a Query in Retry 

State error occurs.
Both Invalid Code/Query Retry Notifies the host to return an opcode check if 

invalid control characters are detected in the data stream or a Query in Retry State error 
occurs.

A black dot fills this button.
3. Select other dialog box options if needed.
4. Choose OK. The dialog box disappears.
Note: To cancel your choice, choose Cancel. The dialog box disappears.

Related Topics
Terminal Setup Command
Terminal Setup Dialog Box



Choosing Screen Updating (Refresh)
This procedure allows you to specify the method used to paint the workstation screen 
with host data.

1. Choose the Terminal Setup command from the Config menu in the Session window 
(<Alt> <C> <T>). The Terminal Setup dialog box appears.

2. Select one of these buttons:
After Last Segment Paints the screen after the last transmission segment is 

received.
After First and Last Segment Updates the screen after the first segment, but waits to 

display additional data until the last segment is received.
After Every Segment Updates the screen after every transmission segment.

A black dot fills this button.
3. Select other dialog box options if needed.
4. Choose OK. The dialog box disappears.
Note: To cancel your choice, choose Cancel. The dialog box disappears.

Related Topics
Terminal Setup Command
Terminal Setup Dialog Box



Configuring the Keyboard
This procedure configures the keyboard in the Config Keyboard Map window.

1. Choose the Keyboard command from the Config menu (<Alt> <C> <K>). The 
keyboard appears.

2. Cut, paste, copy, or exchange keys as needed.
3. Save your changes.

Related Topics
Copying and Pasting Keyboard/Keypad Keys
Copying Code Page and Function List Keys
Cutting and Pasting Keyboard/Keypad Keys
Exchanging Keyboard/Keypad Keys
Saving a File



Configuring the Keypad
This procedure configures the keypad in the Config Keypad Map window.

1. Choose the Keypad command from the Config menu (<Alt> <C> <P>). The 
keypad appears.

2. Cut, paste, copy, or exchange keys as needed.
3. Save your changes.

Related Topics
Copying and Pasting Keyboard/Keypad Keys
Copying Code Page and Function List Keys
Cutting and Pasting Keyboard/Keypad Keys
Exchanging Keyboard/Keypad Keys
Saving a File



Copying and Pasting Keyboard/Keypad Keys
This procedure copies a keyboard or keypad key to another keyboard or keypad location.

1. Choose one of these commands from the Config menu in the Session window:
Keyboard command (<Alt> <C> <K>)
Keypad command (<Alt> <C> <P>)

The keyboard or keypad appears.
2. Select the keyboard or keypad key you want to copy.
3. Choose the Copy command from the Edit menu to copy the selected key to the 

keyboard or keypad buffer (<Alt> <E> <O>).
4. Select the destination key.
5. Choose the Paste command from the Edit menu to copy the key in the keyboard or

keypad buffer to its destination (<Alt> <E> <P>).
Note: To undo the cut or paste, choose the Undo command from the Edit menu 
(<Alt> <E> <U>).

Related Topics
Copy Command
Paste Command
Undo Command



Copying and Pasting Presentation Space Data
This procedure copies data from the Presentation Space to the Windows clipboard, and 
pastes it in the same or any other window.

1. Select the data that you want to copy.
2. Choose the Copy command from the Edit menu (<Alt> <E> <O>). The data is 

copied to the Windows clipboard.
3. Select the destination in the same or another window.
4. Choose the Paste command from the Edit menu (<Alt> <E> <P>). The data is 

pasted in the selected destination.
Related Topics
Copy Command
Paste Command



Copying Code Page and Function List Keys
This procedure copies a key from the Function List, EBCDIC Code Page, or APL Code Page 
to another keyboard or keypad location.

1. Choose one of these commands from the Config menu in the Session window:
Keyboard command (<Alt> <C> <K>)
Keypad command (<Alt> <C> <P>)

The keyboard or keypad appears.
2. Choose one of these commands from the keyboard or keypad Display menu:
APL Code Page command (<Alt> <D> <A>) to display the APL code page 
EBCDIC Code Page command (<Alt> <D> <E>) to display the EBCDIC code page
Function List command (<Alt> <D> <L>) to display the list of 3270 functions

3. Using the left mouse button, select the key you want to copy and drag it to its new
location on the keyboard or keypad.

Note: To undo the copy, choose the Undo command from the Edit menu (<Alt> 
<E> <U>).

Related Topics
APL Code Page Command
EBCDIC Code Page Command
Function List Command



Copying Dead Keys
This procedure copies a dead key from the EBCDIC Code Page to the keyboard or keypad.

1. Choose one of these commands from the Config menu in the Session window:
Keyboard command (<Alt> <C> <K>)
Keypad command (<Alt> <C> <P>)

The keyboard or keypad appears.
2. Choose the EBCDIC Code Page command (<Alt> <D> <E>) from the keyboard or 

keypad Display menu. The EBCDIC code page appears.
3. Choose the Dead Key command (<Alt> <D>) from the code page. The dead keys 

are highlighted.
4. Using the left mouse button, drag the dead key you need to its new keyboard or 

keypad location. The dead key symbol appears on that key.
Note: To undo the copy, choose the Undo command from the Edit menu (<Alt> 
<E> <U>).

Related Topic
EBCDIC Code Page Command



Cutting and Pasting Keyboard/Keypad Keys
This procedure allows you to cut a keyboard or keypad key and paste it to another 
keyboard or keypad location.

1. Choose one of these commands from the Config menu in the Session window:
Keyboard command (<Alt> <C> <K>)
Keypad command (<Alt> <C> <P>)

The keyboard or keypad appears.
2. Select the keyboard or keypad key you want to remap.
3. Choose the Cut command from the Edit menu to relocate the selected key to the 

keyboard or keypad buffer (<Alt> <E> <C>).
4. Select the destination key.
5. Choose the Paste command from the Edit menu to relocate the key in the 

keyboard or keypad buffer to its destination (<Alt> <E> <P>).
Note: To undo a cut or paste, choose the Undo command from the Edit menu 
(<Alt> <E> <U>).

Related Topics
Cut Command
Paste Command
Undo Command



Exchanging Keyboard/Keypad Keys
This procedure allows you to exchange a key in the keyboard buffer or keypad buffer with
another keyboard or keypad key.

1. Choose one of these commands from the Config menu in the Session window:
Keyboard command (<Alt> <C> <K>)
Keypad command (<Alt> <C> <P>)

The keyboard or keypad appears.
2. Select the keyboard or keypad key you want to remap.
3. Choose the Exchange command from the Edit menu to swap the selected key with 

the key in the keyboard or keypad buffer (<Alt> <E> <X>).
Note: To undo the exchange, choose the Undo command from the Edit menu 
(<Alt> <E> <U>).

Related Topics
Exchange Command
Undo Command



Executing 3270 Functions in the Presentation Space
This procedure executes the functions in the Function List in the Presentation Space of 
the Session window.

1. Choose the Function List command from the Window menu (<Alt> <W> <L>). 
The Active Function List window appears.

2. From this list, choose the 3270 function you want to execute in the Presentation 
Space. This function is immediately executed.

3. When you have finished executing functions, close the window.
Related Topics
Function List Command
(Active) Function List Window



Opening a Novell-Provided Keyboard File
This procedure opens any keyboard file provided by Novell. If you save and rename the 
file after remapping the keyboard, use the Open command to open it next time.

1. Choose one of these commands in the Session window:
Keyboard command from the Config menu (<Alt> <C> <K>) to display the Config 

Keyboard Map window
Keyboard command from the Window menu (<Alt> <W> <K>) to display the Active

Keyboard Map window
2. Choose the International command from the File menu (<Alt> <F> <I>). The 

International Keyboard Map dialog box appears.
3. Choose the keyboard size by selecting the Small or Enhanced button. A black dot 

fills this button.
4. Choose the language from the Languages drop-down list box. The list disappears 

and your language choice displays in the Language box. (If no languages are 
listed, choose the directory where the Novell-provided keyboard language files 
reside.)

5. Choose OK. The dialog box disappears and the keyboard now displays the 
character set and keyboard size of the language you chose.

Note: To cancel, choose Cancel. The dialog box disappears.

Related Topics
International Command
International Keyboard Map Dialog Box



Opening a Keyboard or Keypad File
This procedure opens any keyboard or keypad file, whether it is a Novell-provided file or 
a file you created by remapping the keyboard. Novell provides several keyboard files 
(each with the .kyb extension) that you can choose. There is only one keypad file that 
Novell provides, called STD1.PAD.

1. Choose the Open command from the File menu (<Alt> <F> <O>) and the Open 
File dialog box appears and displays the current filename and location.

2. Specify the filename and location as follows:
a. To display the directory where the file resides in the Open File text box, select 

the directory letter from the Files In list box. Enter the directory path followed 
by the filename in the Open File Name text box.

b. Choose the filename and extension from the Files In list box. The filename and 
extension display in the Open File Name text box. If needed, enter the drive 
letter followed by the directory path before the filename in the Open File Name 
text box.

3. Choose the Open button. The keyboard/keypad map of the filename you specified 
in Step 2 displays on the online keyboard or keypad.

Note: To cancel your changes before you choose the Open button, choose Cancel.
The Open File dialog box disappears.

Related Topics
Open Command
Open File Dialog Box



Opening a Session
This procedure opens a new session.

1. To open a printer session in the Printer Session window or the Session window, 
choose the New Session command from the File menu (<Alt> <F> <N>).
The Configuration File Selection dialog box appears.

2. Specify the filename and location as follows:
a. To display the directory where the file resides in the Filename box, select the 

directory letter from the Directories list box. Enter the directory path followed 
by the filename in the Filename text box.

b. Choose the filename and extension from the Files list box. The filename and 
extension display in the Filename text box. If needed, enter the drive letter 
followed by the directory path before the filename in the Filename text box.

Note: To cancel your changes, choose Cancel. The Configuration File Selection 
dialog box disappears.

3. Choose the OK button. The new session displays in the Printer Session or Session 
window.

Related Topics
New Session Command
Configuration File Selection Dialog Box



Receiving a File from the Host
This procedure transfers a file from the host to the workstation.

1. Choose the Receive command from the Transfer menu in the Session window 
(<Alt> <T> <R>). The Receive Session window appears.

2. Enter the filename in the Local text box, or choose the name from the Filename list
box. The filename displays in the Local text box.

3. Enter the host name of the file that will be sent in the Host text box.
4. Specify the source drive letter and path in the Directory list box (if the filename 

was not selected from the Filename box).
5. Choose the Options command from the Config menu in the Receive Session 

window to specify file transfer options (<Alt> <N> <O>). The Send/Receive 
Options dialog box appears.

6. Specify CMS, TSO, or CICS options (referring to your CMS, TSO, or CICS 
documentation) as follows:
a. Select the CMS, TSO, or CICS option button from the Host Type box. A black dot 

fills this button.
b. Select the Append to Data Set, ASCII, and/or CRLF check box as needed. An X 

displays.
c. Enter the packet size in the Packet Size text box.
d. Enter the timeout in the Timeout text box.
e. The Host Program Name text box lists the name of the file transfer program 

installed on the host. The default name is IND$FILE. If the name of your host 
program is different, enter the name of your host program in this box. (When 
the host program name is different, it is usually because the host language 
does not include the $ character.)

f. Choose the language in the Language list box.
g. Enter the directory path of the language translation table (NVLXXLAT.IBM) in the

Language Table Path text box, if it is different than the default path displayed.
h. Choose OK. The dialog box disappears and the Receive Session window 

reappears.
i. Press the Receive button.

The Bytes Received number is updated as file transfers.
Timeout Retries increments if the PC has not responded to the host 
transmission within the timeout period set internally (about 30 seconds). If the 
host does not respond within the maximum timeout set by the user in the 
Send/Receive Session Options dialog box (a maximum of 300 seconds), then file
transfer is cancelled and an error message appears.

Note: Choosing Cancel or Close before choosing the Receive button exits file 
transfer and returns you to the host session. If you cancel after choosing the 
Receive button and abort file transfer, you might need to press the <Enter> 
and/or <PF2> key to get the READY prompt from the host.

Related Topics
Receive Command
Options Command (Receive)
Receive Session Window



Send/Receive Options Dialog Box



Resizing Screen Fonts
There are two ways to resize the screen fonts in the Presentation Space:

Automatic font resizing adjusts the font size according to the size of the Session 
window.

Manual font sizing directly sets the font sizes for the 24x80 Screen Mode and Large 
Screen Mode.

To enable or disable automatic font resizing:
1. Choose the Fonts command in the Config menu of the Session window (<Alt> 

<C> <F>).
Automatic font resizing is enabled when a check appears to the left of the Adjust 
to Fit command. When automatic font resizing is enabled, the 24x80 Screen Mode 
and Large Screen Mode commands are disabled.

2. Choose the Adjust to Fit command (<Alt> <C> <F> <A>) to enable or disable 
this feature.
The Adjust to Fit command alternately enables or disables the feature. For 
example, if automatic font resizing was enabled, the Adjust to Fit command 
disables the feature.

To select specific font sizes for the Session window:
1. If automatic font resizing is enabled, disable automatic font resizing as described 

above.
2. Choose the Fonts command in the Config menu of the Session window (<Alt> 

<C> <F>); then choose one of these:
To resize the screen font for the 24x80 Screen mode, choose the 24x80 Screen Mode 

command (<Alt> <C> <F> <2>). The 24x80 Screen Mode dialog box appears, displaying 
the current font size above the font sizes list.

To resize the screen font for the Large Screen mode, choose the Large Screen Mode 
command (<Alt> <C> <F> <L>). The Large Screen Mode dialog box appears, displaying 
the current font size above the font sizes list.

3. Scroll through the full list of font sizes.
4. Select a size.
5. Choose OK. The dialog box disappears, and the Presentation Space font size 

changes to display your choice.
Note: To cancel your choice, choose Cancel. The dialog box disappears. To reset 
your choice after you choose OK, display the dialog box and choose Optimize. This
changes the font size to 8x16 (for Model 2), 8x12 (for Model 3), 8x10 (for Model 
4), and 6x14 (for Model 5). The dialog box disappears. To reset the font size to its 
original size you can use the Reset Config command (if you use this command, 
any other changes you made since the file was last saved will also be reset to 
their default values). The Reset Config command will not reset changes to the 
keyboard unless the Config Keyboard Map window is open at the time you choose 
the Reset Config command.

Related Topics
(Fonts) 24x80 Screen Mode Command
(Fonts) 24x80 Screen Mode Dialog Box
(Fonts) Adjust to Fit Command
(Fonts) Large Screen Mode Command
(Fonts) Large Screen Mode Dialog Box





Saving a File
This procedure saves changes into a file, and allows you to rename it and relocate it into 
a different directory.

1. Choose the Save As command from the File menu in the Printer Session window, 
Session window, or Config Keyboard/Keypad Map window (<Alt> <F> <A>).
The Save As dialog box appears, displaying the current filename and location.

2. If you want to
Rename the file, enter the new filename in the text box.
Relocate the file, select the new drive letter in the list box (the new drive letter 

appears in the text box).
3. Specify the new directory path next to the drive letter in the text box.
4. Choose the Save button. The dialog box disappears.
Note: To cancel a save before choosing the Save button, choose Cancel. The 
dialog box disappears.

Related Topics
Save As Command
Save As Dialog Box



Sending a File to the Host
This procedure transfers a file from the workstation to the host.

1. Choose the Send command from the Transfer menu in the Session window. The 
Send Session window appears (<Alt> <T> <S>).

2. Specify the file to be sent and its current location as follows:
a. Enter the destination host name in the Host text box.

For VM/CMS, this is filename (fn) filetype (ft) filemode (fm). Separate with 
spaces (for example, TESTFILE TEST A1). Fn and ft are required, and may be up 
to 8 characters long. Fm is optional—if omitted, the default of A1 is assumed.
For TSO, this is the TSO data-set-name parameter. This parameter is required. 
Follow this by entering the member-name parameter that is required if the TSO 
data set is partitioned. The data-set-name (with member-name, if required) 
may be enclosed in single quotes to indicate that it is the complete name (that 
is, that it is not to be prefixed by TSO).
For CICS, this is the host filename (fn). This parameter is required, and must 
conform to the CICS filename/program name/transaction ID conventions (where
the initial character is a letter and the remaining characters are letters or 
digits). Do not separate with a space (for example, TESTFILE.TEST(2).

b. Enter the filename in the Local text box or choose the name from the Filename 
list box. The filename displays in the Local text box.

c. Specify the source drive letter in the Directory list box, and type the directory 
path in front of the filename in the Local text box (if the filename has not been 
obtained from the directory in the Filename box).

3. Choose the Options command from the Config menu in the Send Session window 
to specify file transfer options (<Alt> <N> <O>). The Send/Receive Options 
dialog box appears.

4. Specify CMS, TSO, or CICS options (referring to your CMS, TSO, or CICS 
documentation) as follows:

For a VM/CMS host:
a. Select the VM/CMS option button from the Host Type box. A black dot fills this 

button.
b. Select the Append to Data Set, ASCII, and/or CRLF check box as needed. An X 

displays.
c. Enter the required record length or leave the default in the Record Length text 

box.
d. Enter the packet size in the Packet Size text box.
e. Enter the timeout in the Timeout text box.
f. The Host Program Name text box lists the name of the file transfer program 

installed on the host. The default name is IND$FILE. If the name of your host 
program is different, enter the name of your host program in this box. (When 
the host program name is different, it is usually because the host language 
does not include the $ character.)

g. Choose the language in the Language list box.
h. Enter the directory path of the language translation table (NVLXXLAT.IBM) in the

Language Table Path text box if different than the default specified.
i. Select the Fixed or Variable option button in the Record Format area. A black 

dot fills this button.



j. Choose OK. The dialog box disappears, and the Send Session window 
reappears.

For a MVS/TSO host, repeat the CMS steps except:
a. Select the MVS/TSO option button from the Host Type box. A black dot fills this 

button.
b. Specify the block size in the Block text box.
c. Select the Undefined button (if required) in the Record Format area.
d. Enter values in the Space, Increment, or Average Block text boxes in the TSO 

Options area.
e. Select the Tracks, Cylinders, or Blocks button from the Space Allocated In area 

of the TSO Options.
f. Choose OK. The dialog box disappears, and the Send Session window 

reappears.
g. Save the options you specified if needed for future transfers.

For a CICS/VS host, repeat the CMS steps except:
a. Select the CICS/VS option button from the Host Type box. A black dot fills this 

button.
b. You do not specify record format in the Record Format area.
c. Enter the required CICS options in the Special CICS Options text box. If there are

options, enter them within parentheses; then skip a space and enter comments 
if needed. If no options are needed but you need to enter comments, enter 
parentheses without anything in them, followed by a space and comments.

d. Choose OK. The dialog box disappears, and the Send Session window 
reappears.

e. Save the options you specified if needed for future transfers.
5. Choose the Send button to send the file. When transfer has completed:
The entire Percentage Complete box is shaded.
The File Size number appears.
The Bytes Sent number appears.
Timeout Retries increments if the host has not responded to the PC transmission 

within the timeout period set internally (about 30 seconds). If the host does not respond 
within the maximum timeout set by the user in the Send/Receive Session Options dialog box
(a maximum of 300 seconds), then file transfer is cancelled and an error message appears.

Note: Choosing Cancel or Close before choosing the Send button exits file 
transfer and returns you to the host session. If you cancel after choosing the Send
button and abort file transfer, you might need to press the <Enter> and/or 
<PF2> key to get the READY prompt from the host.

Related Topics
Send Command
Options Command (Send)
Send Session Window
Send/Receive Options Dialog Box







3270 Workstation Color Control Dialog Box
For the workstation's color monitor, this dialog box allows you to

Change host-assigned base, default extended, extended, background/blinking, and 
OIA colors

Change Session window colors to any color supported by a 256-color hardware driver
Change your Presentation Space colors to monochrome
Choose 3270-type colors or regular PC colors
Reset colors to display adapter default colors

The palette in this dialog box consists of 16 color squares. You can redefine any color 
square to any of the 256 colors if they are supported by your hardware driver.
Related Topics
Changing Colors Supported by the Hardware Driver
Changing Host-Assigned Colors
Changing Presentation Space Colors to Monochrome
Choosing 3270 Host or Regular PC Colors



APL Code Page Dialog Box
This dialog box consists of APL symbols and characters. It displays when you choose the 
APL Code Page command under the Display menu in the Config Keyboard Map or Config 
Keypad Map window. You can copy these characters or symbols to the keyboard or 
keypad, but you cannot remap them.
Related Topics
APL Code Page Command
Copying Code Page and Function List Keys



Configuration File Selection Dialog Box
The Printer Session and Session windows allow you to create a new configuration file or 
open an existing one.
Related Topics
New Session Command
Opening a Session



Connection Configuration Dialog Box
Allows you to choose the server name, service name, user ID, and LU category. The LU 
category specifies the LU group from which you want to obtain a session. You can choose
one of these LU categories:

Any Choose if the LU group (Public, Pooled, or Dedicated) can be any.
Public Choose for an LU that is neither pooled nor dedicated.
Pooled Choose for a group of LUs that have one or more characteristics in common 

(such as all users in this group will have a Model 2 session with Model 2 displays).
Dedicated Choose for an LU that has a unique configuration (such as a reserved 

address for a specific user).
Related Topic
Connection Command



Connection Reminder Dialog Box
Reminds you of the server name, service name, user ID, and LU category for the current 
session.
Related Topic
Connection Reminder Command



Define Custom Color Dialog Box
Allows you to define custom colors for the 16 color squares in the 3270 Workstation Color
Control dialog box. This box displays when you choose the Define button, which works 
only if your hardware driver supports 256 colors.
When you define a custom color as described in the Changing Colors Supported by the 
Hardware Driver procedure, note that any Session window color that was defined by the 
old color in the square will change to the new color you defined.

Note: Be careful when you redefine a custom color in a color square. For 
example, if you change blue to red, and the OIA colors were blue and red, the OIA 
area will all be red and you will not be able to see the OIA symbols. If this 
happens, you can use the Optimize button to reset the color, but the color will be 
reset to the hardware adapter's default for the old color and not the original color 
provided by Novell.

After you redefine the color square to a new color, you can use this square to redefine 
any color in the Session window to the new color by following the Changing Host-
Assigned Colors procedure.
Related Topics
3270 Workstation Color Control Dialog Box
Colors Command
Changing Colors Supported by the Hardware Driver
Changing Host-Assigned Colors



EBCDIC Code Page Dialog Box
Displays the EBCDIC Code Page, which allows you to

Copy code page characters or symbols to the keyboard or keypad
Choose the Dead Key command

When you choose the code page's Dead Key command, the code page dead keys are 
highlighted. You can use a dead key to create a combination of a character and symbol. 
(For example, you may want to copy an accent from the code page onto a keyboard 
letter to create an accented letter that is used in your country.)
EBCDIC Code Page characters and symbols cannot be remapped.
Related Topics
EBCDIC Code Page Command
Copying Dead Keys



(Fonts) 24x80 Screen Mode Dialog Box
Allows you to resize screen fonts so scrolling is unnecessary. The screen size is assigned 
in the host Bind command. This mode assigns the screen size as the number of lines by 
the number of characters per line. If you are not sure if this mode is active, ask your IBM 
systems programmer.
Related Topics
(Fonts) 24x80 Screen Mode Command
(Fonts) Adjust to Fit Command
(Fonts) Large Screen Mode Command
Resizing Screen Fonts



(Fonts) Large Screen Mode Dialog Box
Allows you to resize screen fonts so scrolling is unnecessary. The screen size is assigned 
in the host Bind command. This mode assigns the screen size as the number of lines by 
the number of characters per line. If you are not sure if this mode is active, ask your IBM 
systems programmer.
Related Topics
(Fonts) 24x80 Screen Mode Command
(Fonts) Adjust to Fit Command
(Fonts) Large Screen Mode Command
Resizing Screen Fonts



Open File Dialog Box
Allows you to open a keyboard or keypad file. These files operate as follows:

Keyboard files define the characters and functions assigned to the keys in the Active 
Keyboard Map and Config Keyboard Map windows. Opening a keyboard file changes the 
layout (mapping) of the keys in the Keyboard Map windows to match those defined by the 
keyboard file. The keyboard files from Novell are labeled *.KYB.

Keypad files define the characters and functions assigned to the keys in the Active 
Keypad Map and Config Keypad Map windows. Opening a keypad file changes the layout of 
the keys in the Keypad Map windows to match those defined by the keypad file. The keypad 
files from Novell are labeled *.PAD.

The Open File dialog box allows you to open a file from any disk drive and directory. 
Related Topics
Open Command
Opening a Keyboard or Keypad File



Function List Dialog Box
Displays the Function List that includes the chart of 3270 functions. You can copy any 
function in the chart to the keyboard or keypad, but you cannot change its mapping.



International Keyboard Map Dialog Box
Allows you to open a Novell-provided international keyboard file, which has a .kyb 
extension. When you open this file, the keyboard displays the associated language map 
and keyboard size.
After you open this file, you can use the keyboard to enter data into the Presentation 
Space or remap the keyboard. For details, see the NetWare 3270 LAN Workstation for 
Windows User's Guide.
Related Topics
International Command
Opening a Novell-Provided Keyboard File



New Keypad Dialog Box
Allows you to enter the number of keys for a new keypad as rows by columns (rows X 
columns). When saved, a new file with the .pad extension is created. You can define up 
to 7 keys per row or column. You can configure up to 49 keys.
Related Topic
New Command



Printer Setup Dialog Box
Specifies the following:

The printer to be used for printing
The Print Manager (see your Windows documentation for an explanation of the Print 

Manager)
Setup options for the printer (see your printer documentation for an explanation of 

these options)
This command does not work if the On/Off switch in the Printer Session window 
(simulating a 3287 printer panel) is on. For details about the Printer Setup window, see 
your IBM 3287 printer documentation.
Related Topic
Printer Setup Command



Reset Dialog Box
Allows you to reset all changes you made in the Printer Session or Session window, if you
have not yet saved your changes. All values return to their defaults.
Related Topics
Reset Config Command (Printer Session Window)
Reset Config Command (Session Window)



Save As Dialog Box
Allows you to save the changes you make to a file, rename it, and relocate it into a 
different directory.
Related Topics
Save As Command
Saving a File



Select Code Page Dialog Box
Allows you to choose which EBCDIC code page will be used during the session.
Related Topics
Select Code Page Command
Code Page Command
Choosing the EBCDIC Code Page



Send/Receive Options Dialog Box
Allows you to choose CMS, TSO, or CICS options for file transfer.
Related Topics
Send Command
Send Session Window
Options Command (Send)
Sending a File to the Host
Receive Command
Receive Session Window
Options Command (Receive)
Receiving a File from the Host



Terminal Setup Dialog Box
Allows you to choose numeric lock, opcode checks, form feeds, and/or screen updating 
(refresh) as follows:

Numeric lock locks the keyboard when an attempt to enter non-numeric data into a 
numeric field is made.

Opcode checks (Op Checks) can be returned by the host if invalid control characters 
are detected in the data stream and are reported to the host, or a Query Retry State error is 
reported to the host. If checking is off, invalid control characters may display as hyphens.

Form feeds determine blank page ejection during printing of screens.
Screen updating (refresh) determines how the screen is updated with host data.

Related Topics
Choosing Numeric Lock
Choosing Opcode (Op) Check Returns
Choosing Form Feeds
Choosing Screen Updating (Refresh)




